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This Month’s General Meeting
Tuesday, November 9, 2021
will start at 3:00 P.M. @
FFG Christ Lutheran Church

Note: We do not publish an issue in December, so this
will be the last Gazette for 2021

Social Distancing is recommended.
Face coverings are NOW REQUIRED
.

November 9th. Presentation
@ 3:00 P.M.

Navigating a CC (Covid Christmas)
Chip shortages, transportation delays,
higher prices and Covid. Those are all
going to make this a very different gift
season than in years past.
PPCUG President, Steve Rosenstein, will
be giving tips and updates on what to buy
and what to avoid this year at the PPCUG
November meeting.
Steve has years of experience in the electronics business and knows the secrets for
getting a good deal.
Don't go out into the chaos of this year's
holiday market without knowing the deal
ahead of time.

We wish you all A Happy Holiday Season
and a successful New Year
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Please Note: Starting with the June meeting, we will stop

having summer/winter hours. Meetings will then be on the
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Location: Christ Lutheran Church
481 Snead Drive, Fairfield Glade TN
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Join the Club!

Anyone interested to attend the general meeting or any of
the SIG meetings as a guest will be charged $3.00 per person for any or all meetings in that month. Afterwards, you
are encouraged to become a member of the Plateau PC
Users Group. Our Club cannot exist without you, the
members.

2021-2022 PPCUG, Inc. Board Members

Membership Dues

Our annual dues are now payable July 1st. of each year.
Annual dues are $24 per single person / $30 per family.
Persons/families joining during the fiscal year have dues
payable as follows:

Join In

July Sept

Oct Dec

Jan Mar

Apr June

Single

$24

$18

$12

$6

Family

$30

$22

$15

$7

BOARD OF DIRECTORS DISCLAIMER
All members of the Plateau PC Users Group are willing
to help one another in the area of advice and tutorial instruction over the phone. If you should require more involved services or instruction, we have a few members
who are very knowledgeable in several areas. As a responsible
consumer, it is up to you to discuss, before retaining a
member, any and ALL charges for repair services and
time consuming tutorial activities.
It is not the desire of this Board of Directors to set fees
for individuals for services rendered, nor the responsibility to intervene between members who enter into a contract among themselves.
The GAZETTE is published using the following: Microsoft Word, Microsoft Publisher, and Microsoft Windows. The Gazette is the monthly newsletter of the Plateau PC Users Group, Inc.
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Use keyboard shortcuts to carry out tasks quickly
Windows and most applications support another type of shortcut – the kind where pressing a combination
of keys on your keyboard allows you to carry out common tasks such as copying, pasting, saving and printing quickly, without having to hunt around in menus and toolbars for the right command. A handful of essential, everyday ones below that will quickly become second nature once you have used them a few times.
Windows Key + D – Show the desktop
Windows Key + E – Open a File Explorer window
Windows Key + I – Open the Settings app
Windows Key + S – Search your computer
Ctrl + Shift + Esc – Open the Task Manager
Alt + Tab – Switch between open program windows
F2 – Rename the selected item
F5 – Refresh your current webpage/program window
F11 – Toggle full-screen mode in current program

Ctrl + A – Select all
Ctrl + C – Copy the selection item(s)
Ctrl + V – Paste the selected item(s)
Ctrl + X – Cut the selected items

Ctrl + Z – Undo the last action
Ctrl + Y – Redo the last action
Ctrl + V – Paste the current document or picture
Ctrl + S – Save the file you are working on

Ctrl + W – Close the current program
** Visit the PPCUG W ebsite **
At: www.PPCUGinc.com.
Read all about our club activities and scheduled monthly meetings, also current and past issues of the Gazette Newsletter. Links also to the Meeting Handouts on past presentations.

Send your comments and suggestions to the PPCUG Webmaster, Alan Baker
jackal33980@gmail.com (931) 239-0877
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How to Add Border to a Page in Microsoft Word

By Sandy Writtenhouse

If you want to spruce up your document, brochure, invitation, or
If you’re creating a document in Microsoft Word that would look better with a page border, you can add
one easily. Word gives you flexible options, whether you want a simple black line for something like a brochure or a whimsical border for something like an invitation.
Here, we’ll show you how to add a page border in Word and customize it exactly as you want.
Add a Page Border in Word
Open Microsoft Word to your document on either Windows or Mac. Head to the Design tab and click
the Page Borders button in the Page Background section of the ribbon.

When the Borders and Shading window opens, confirm that you’re on the Page Border tab. You can then
get right to the customization options for your border.

(Continued on page 5)
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Customize a Page Border in Word
On the left side of the window, you can start by picking a style under Setting. This lets you select something like a shadow or 3-D effect or go with a box style. To the right, choose the line Style you’d like to use
and the Color directly below it.

If you prefer to use something fun and different, click the Art drop-down list at the bottom for a great selection of creative borders. You’ll find a nice assortment of color options like hearts, stars, ice cream cones,
flowers, holiday images, and more.

Whether you use a line style or artsy border, you can then adjust the Width of the border. You’ll see the
preview on the right side update for a good view as you do so.

(Continued on page 6)
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Also, in the Preview section, you can use the small boxes to enable or disable the border from a particular
side of the document. Then, choose “Apply to” if you only want the border in a certain section or the
whole document.

To adjust the margins when using a page border, click the Options button. You can then enter the number
of font points to use for the top, bottom, left, or right margin. Then below, click Measure from to use those
numbers of points from the edge of the page or the text of your document.

You have a few additional settings in this window you can adjust if you like. Below Options, check or uncheck the boxes for always displaying in front, aligning the paragraph borders with the page border, and
surrounding headers or footers.

Note: Depending on your selections, some Options may be gr ayed out.
(Continued on page 7)
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Click OK when you finish changing the options. Then, click OK in the Borders and Shading window to
apply your page border.

Remove a Page Border
If you decide later to remove the page border you’ve applied, you can do so easily.
1. Go back to the Design tab and click Page Borders.
2. On the Page Border tab, click None under Settings on the left.
3. Click OK, and your bor der should be r emoved.
4.

Page Borders in Microsoft Word
No matter what type of border you choose, whether you apply it to your whole document or just a section,
Word gives you terrific options. You can add some pizzazz to your flyer or outline your document with a
simple page border.

How to Prevent Digital Eye Strain

In today’s time, we use digital screens for just about everything to relax, to work, play, or to keep up with
our daily lives. Researchers have discovered that it only takes two hours of screen time per day to have a
90% risk of developing digital eye strain.
Why Do Digital Screens Cause Eyestrain?
You normally blink 15-20 times a minute, and which blinking often spreads tears evenly over your eyes,
keeping them from getting dry and irritated. Studies have shown that people blink less than half as often
when reading or watching on a screen.
(Continued on page 8)
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Symptoms of Digital Eye Strain
There is an excellent chance that digital eye strain condition commonly affects many patients without
realizing it. Here are some of the symptoms associated with digital eye strain:
·
·
·
·
·
·

Dry eyes
Eyestrain
Frequent headaches
Blurred vision
Itching or burning sensation in the eyes
Neck and shoulder pain

Working from home on your computer or at the office, checking your email, or scrolling through social
media on your smartphone, could result in having these symptoms if proper techniques are not in place to
ensure your productivity does not suffer impact. Here are a few tips to help minimize digital eye strain:
Organize Your Workspace At An Eye Comfort Level
Double-check your posture to ensure there is enough space between you and your computer. Most people
find it more comfortable to view their laptop when their eyes are looking downward. The proper viewing
for the computer should be 20 degrees below eye level as measured from the center of the screen and 20
inches from the eyes.
Check Your Lighting
It is essential to customize your lighting needs. Position the computer screen to avoid glare, particularly
from room lighting or windows. Also, using a glare filter for your screen would be a good alternative as
well.
Give Your Eyes A Quick Break

Make the 20-20-20 rule part of your daily routine. One of the reasons people suffer from digital eye
strain is that they tend to blink less often while looking at digital screens. To give your eyes a break,
make the
20-20-20 rule a habit: Every 20 minutes, look at something 20 feet away for at least 20 seconds. It will do
your eyes good.
Adjust Your Smartphone Settings

Lower the color temperature of your screen. The screen should be lighter or darker than your surroundings. Also, raising the contrast and making the text larger will ensure that your smartphone device settings are optimal for eye health.
Incorporating these, few eye health tips above and making adjustments to your daily habits on how you
use your digital devices can be easier on your eyes.

(Continued on page 9)
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Don’t Forget To Schedule Your Eye Exam
If you are experiencing eye discomfort, vision changes, or headaches, make an appointment with your
eye doctor.

To be prepared for your appointment, list any symptoms you have been having, list your key medical
information; keep a journal of the time you spend on activities that strain your eyes, and a list of questions you would like to ask your eye doctor.

Dear Tech Support,
Last year I upgraded from Boyfriend 5.0 to Husband 1.0 and noticed a distinct slowdown in overall
system performance, particularly in the flower and jewelry applications, which operated flawlessly under
Boyfriend 5.0 .
In addition, Husband 1.0 uninstalled many other valuable programs, such as:
· Romance 9.5 and
· Personal Attention 6.5,
And then installed undesirable programs such as :
· NBA 5..0,
· NFL 3.0 and
· Golf Clubs 4..1 ..
Also Conversation 8.0 no longer runs, and Housecleaning 2. 6 simply crashes the system.
· Please note that I have tried running Nagging 5.3 to fix these problems, but to no avail.
What can I do?
Signed,
Desperate.
DEAR DESPERATE,
First, keep in mind,
· Boyfriend 5.0 is an Entertainment Package, while
· Husband 1.0 is an operating system.
(Continued on page 10)
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Please enter command: ithoughtyoulovedme.html and try to download Tears 6.2 and do not forget to install
the Guilt 3.0 update.
.
· If that application works as designed, Husband 1.0 should then automatically run the applications Jewelry
2.0 and Flowers 3.5.
However, remember, overuse of the above application can cause Husband 1.0 to default to Grumpy Silence
2.5 , Happy Hour 7.0 or Beer 6.1 ..
· Please note that Beer 6. 1 is a very bad program that will download the Farting and Snoring Loudly Beta.
Whatever you do, DO NOT under any circumstances install Mother-In-Law 1.0 (it runs a virus in the background that will eventually seize control of all your system resources.)

In addition, please do not attempt to reinstall the Boyfriend 5.0 -program These are unsupported applications and will crash Husband 1.0 .
In summary, Husband 1.0 is a great program, but it does have limited memory and cannot learn new
applications quickly. You might consider buying additional software to improve memory and performance..
We Recommend

· Cooking 3.0 and
· Hot Lingerie 7.7.

Good Luck!
Tech Support

Backup Using Windows 10 – Protect your Data (and System)
By Phil Sorrentino, Newsletter Contributor, Sarasota Technology Users Group
www.thestug.org
philsorr (at) yahoo.com
As many of us have learned from hearing some sad stories, data backup needs to be an integral part of using
our computers. As such, you would think that the Operating System developer would have included Backup
as part of the OS; well, fortunately, they did. Not only did Microsoft include the ability to back up your data, but it included the ability to back up your system as well. Although Windows 10 offers these backup solutions, this has not always been the case. In the Operating System's early days (maybe all the way leading
up to Windows 7), Data and System backup was left to third-party software developers, who provided software such as Acronis True Image, Goodsync, and Macrium Reflect. So, at this point, many of us are using
other solutions for Backup, like FreeFileSync for Data backup and EaseUs Todo for System backup. But
the Windows 10 features may be a good choice for someone who does not want to get involved with new
applications but wants to start to protect their data at least, and possibly even have a System Image backup.
(Continued on page 11)
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This may be obvious, but the reason for having a backup is to restore a file, a folder, or a collection of files
and folders if something is accidentally destroyed or deleted. The backup is just a copy, an exact duplicate,
and is not processed in any way so that the backup files can be used by any programs that could use the
original files. (Most backup software does not process the data files at all, but some backup software does. Some
backup applications process the files to make the resulting backup files smaller, probably to save space, but this makes
the files useable only by the backup application and not the original applications.)
So, first, let's review the difference between Data and System. Data is all the files created by applications.
This could be documents which may be the output from Word or Excel, pictures that come from a camera
or your phone, music purchased from iTunes, videos that have been produced by MovieMaker, financial
and tax records that TurboTax may have produced, etc. Data is basically all the "stuff" you produce while
using your computer software applications. Hopefully, in File Explorer, you have the "File name extensions" box in the View Tab checked so you can identify these files. Once that box is checked you will see
file extensions on each file like .docx, .xlsx, .jpg, .png, .mp3, .wav, .mov, .avi, .ttax. Hopefully, most of
these are familiar to you.
System, on the other hand, is a copy of the Operating System and all of its components (referred to as the
Operating Environment), as they exist in the memory of your operating computer. This includes Applications installed like Photoshop, Virus, and Malware software like Malwarebytes, added Utilities like
CCleaner, Drivers added to the OS, and Updates to all the above. The resulting System backup file(s) is
typically referred to as an Image (of the Operating Environment). The Image can only be created by a specific imaging program, and the image created can then only be used by that same imaging program to restore the Image. (The reason for having an image is to be able to re-install your "Operating Environment"
if, or rather when, a virus or hardware problem makes your system unusable. For example, ever have a
Disk failure or a Malware infection?)
Now that we know what is being protected when we say Data or System Backup let us look at the backup
features provided in Windows 10. The Data backup feature is in The "Update & Security" section of Settings. (Windows Start – Settings – Update & Security) Next, choose Backup in the list on the left. The
backup feature is called "Back up using File History." The first step is to connect an external or portable
drive to the computer using one of the USB connectors and then click the "+ Add a drive." Next in the list
of drives, select the drive you just connected. This will change the "+" to "Automatically back up my files"
with the switch set to "On." Your added drive is now set up to be the backup drive. Next, select "More Options" so you can determine how often your files are backed up (default is "every hour"), how long to keep
your backup files (default is "forever," but "until space is needed" may be a better choice), and what files
are backed up. (To remove a folder, click the folder and then click "Remove," to add a folder, click "+Add
a folder" under "Back up these folders." There is even an "Exclude these folders" option at the end of the
list of folders.) If, or when, you no longer want to backup to the drive shown, click "Stop using drive" under "Backup to a different drive." To restore a file or folder from a backup drive, choose "Restore files
from a current backup" at the bottom of the "Backup options."
Creating a System Image is, as usual, a little more complicated. It is not in Settings, but rather it is in the
Control Panel. Click the Search icon next to the Start button and type in Control. Select "Control Panel"
and when in Control Panel select "Backup and Restore (Windows 7)." (I know this is Windows 10.)
Choose "Create a system image" on the left side of the "Backup or Restore your files" choose "Create a
system image." On the "Where do you want to save the backup" screen, select a hard drive. Select the C:
drive if it is not selected already on the "Which drives do you want to include in the backup" screen. And
(Continued on page 12)
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finally, on the "Confirm your settings" screen, review the settings and "Start the backup." You will also
have to "Create a system repair disc" to use to boot your system. Restoring your System Image is done by
selecting "Restore my files" on the bottom of the "Backup or Restore your files" screen. Creating a System Image is relatively easy; however, "Restoring" an Image takes a little training, even though the individual steps are not difficult. My practical feeling is that Restoring an image should be done only by, or
with the help of, a tech-savvy friend. Even if you don't attempt to create/restore an image, make sure you
backup your data.

3 for a Quarter – Tips & Tricks
By Debra Carlson, Editor, CLC Computer Club
Tech Notes, Q3 2021
cvc.computer.club (at) gmail.com

Number 1 – Refurbs
Buying items refurbished seems like the perfect solution. Products labeled “refurbished” are fully functional but can’t technically be sold as “new” anymore for reasons vary by manufacturer. Because of this,
they’re typically cheaper though “hundreds of dollars” in unlikely for a current model.
Refurbished can mean something different depending on the manufacturer. However, it usually means
that a product was purchased by a customer and eventually returned while still under warranty because
the buyer had an issue. The machine is “repaired” and resold. The amount of upgrade/repair differs by
manufacturer.
Many people assume all of the following definitions, seen on outlet sites, are refurbished. They are not.
Here is the list of terms to help - Shipping and/or exterior damage: Dents, scratches, or other surface damage.
 Open box: Purchased, used, then returned by a customer. They might show small signs of wear
and cosmetic damage but are considered “refurbished” because they were examined and found to
be in resale condition.
 Unopened/returned: A return that was never even opened.
 Demo models: Products used in stores, displayed at trade shows, or loaned to reviewers might be
repackaged and eventually sold as refurbished items.
 Renewed models: Generally, preowned machines have been cleaned and, perhaps, loaded with a
new operating system for resale.
 Check with your retailer and for the certifications and warranties offered on machines (note: some
open box machines, e.g., only carry what is remaining on the original warranty. If this was a display machine, the warranty might be almost over by your time of purchase.). Retailers that don’t
offer a return policy are best avoided since you have no guarantee that you’ll actually get your
money’s worth or have support if something malfunctions. Refurbished items being sold “as-is”
are a gamble, so you have to weigh your purchasing decisions carefully.
 Good refurb machines can be great for trips or students where there is a higher possibility of
breakage. They can also be great for learning “deep dives” before spending money for a new computing adventure.
 Remember to check out the current supported technology level and look at the life expectancy for
the device. For example, if it is a certified refurb, but the model will not support operating system
(Continued on page 13)
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upgrades after two years, the device has a 2-year life. Is it worth the price you are paying with this in
mind?
Number 2 – Google Privacy Check (and others) myaccount.google.com/data-andpersonalization
Go to the link above when you are logged into your Google account, and you might be surprised at the number of options available for your customization.

If you’ve never been through this area and you have a Google account, DO
IT NOW. The Google home page will have taunted you to do it – you may have even gotten emails about it.
DO IT.
The Privacy checkup will walk you through all the settings.
Not a Google customer? How about Facebook?

Most online platforms let you choose at least some of your information that others can see or search. Review
this often. Your information should be yours to control.
Note: 2-factor authentication. If you read email in a “client” rather than from a web page, you may avoid
getting to your email. It’s worth asking for help or guidance on this option.

Number 3 Zooming with a Mouse
If you have a mouse with a scroll wheel, holding down your CTRL key in Windows and most Windowscompliant apps will Zoom in or out (up for in, down for out). Great for viewing small print on one part of a
page.
For Mac desktops, go to Accessibility in System Preferences, and click the box shown below.
Note: this will Zoom the currently viewed area of a page, so you will need to Zoom out to move to another
area of the page
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Keyboard — Refresher Quiz
By Jim Cerny, Forums Coordinator / Instructor, Sarasota Technology Users Group
www.thestug.org
vp1 (at) thestug.org
Most of us have been using a computer keyboard for years, so you are probably comfortable using it. But a
good review of these helpful keyboard keys can make your texting much easier. There are keyboards for
computers, laptops, on-screen touch keyboards for tablets and phones. They may look a bit different and
have some different keys, but they all will (basically) do the same thing (well, with very few exceptions).
How many of these do you remember? Answers are provided at the end of the article, but don’t peek!
1. How do you repeat a letter or symbol?
2. What do you call that vertical line that appears BETWEEN letters to allow you to insert or delete text?
3. How do you enter all capital (uppercase) letters?
4. What does hitting the “delete” key do when you are editing text NOT highlighted?
5. How do you highlight or select the text you want to delete, move, or copy?
6. What is the difference between “cut” and “copy”?
7. What does the “tab” key do?
8. What are “function” keys (the “f”-keys)?
9. Can you use a keyboard to enter a menu option?
10. What do the arrow keys do?
11. What does the ESCAPE key (Esc) do?
12. Can you find these controls on your keyboard? Volume up or down, insert, page up or down, or “call a
10-year-old for help”?
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Plateau PC Users Group, Inc.
Revised Application for Membership for 2021
------- New Member

------ Renewing Member

Return this application with check foe annual dues payable to “PLATEAU PC USERS GROUP” Return to
the club Treasurer during our meeting or mail to “PPCUG Treasurer. P.O. Box 3787, Crossville TN 38557”
Our annual dues are now payable July 1 st. of each fiscal year.
Persons// families joining during the fiscal year have dues payable as follows:
Join In

July - Sept

Oct - Dec

Jan - Mar

Apr - June

Single

$24

$18

$12

$6

Family

$30

$22

$15

$7

Date: --------------------

Amount Paid: $ -------------------- by Cash ------ , or Check (# ----------------------- )

-------------------------Last Name

------------------------First Name

-------------------------------------------Family Member (if family membership)

------------------------------------------------------------------------------Address:
-------------------------------------City

-------State

--------------Zip Code

(-------------) ----------------------------Phone Number

E-Mail address: ---------------------------------------------------------------------Please Print
I have belonged to a Computer Club before: Yes ----------- No -----------I have used PC’s since (year): -----------------I have knowledge in the following areas that I would be willing to share with club members:

Note: Dues are now back to pre COVID-19 time, and due by July 1st

July 2021
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January 2022
Sun

Mon

Tue

Wed

Thu

Fri

Sat
1

2

3

4

5 2:00 P.M. 6

7

8

9

10

11 3:00 P.M.
General Mtg.
Presentation.
Followed by
Q&A Session

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31
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